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A.1. Objectiu 
 
Intentarem comprovar com respon el programa ANSYS i com es comporta un material 
com és la pedra de Girona caracteritzat elàsticament . Utilitzarem diferents estats de 
tensions a una geometria molt simple per poder-ho contrastar amb els valors teòrics. 

 
A.2. Assaig del model lineal. 
 
A.2.1 Introducció 

 
La geometria a la que aplicarem els diferents estats de tensions és un cub de 1 cm3 
que constarà d’un sol element SOLID 65 d’un material ceràmic com és la pedra de 
Girona. 

 
Característiques del material: 

- Mòdul elàstic o de Young (E)= 7,47·1010 Pa 
- Coeficient de Poisson(μ)= 0,3357 
- Tensió límit a la tracció(σut)= 7,32·106 Pa 
- Tensió límit a la compressió(σuc)= 7,32·107 Pa 

 

 
A.2.2 Assaig uniaxial a tracció 

 
S’aplicarà una pressió de 8 MPa a tracció per assegurar-nos que es supera el límit de 
tracció i així podrem representar la corba tensió-deformació de la figura 1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. A.1.Corba tensió deformació de l’assaig uniaxial a compressió 
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A.2.3 Assaig uniaxial a compressió 

 
Aquest assaig tracta d’aplicar una càrrega a compressió de 80 MPa, que és un valor 
superior a la tensió límit a compressió definida en les característiques del material 
pedra de Girona (σuc=73,2 MPa). 
 
 
 
 
.  
 
 
 
 
 
 
 
 
 

Fig. A.2.Corba tensió deformació de l’assaig uniaxial a compressió 

 
S’observa que es va aplicant una compressió fins arribar al límit de tensió a 
compressió. El programa ANSYS obté resultats fins al valor que supera a aquest valor 
límit en aquest instant correspon al punt de ruptura del material. 

 
A.3. Assaig del model no lineal. 
 
A.3.1 Introducció 

 
El model concrete també permet introduir en les característiques del material un 
comportament plàstic subjecte a l’evolució d’una corba esforç-deformació prèviament 
introduïda.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. A.3.Corba tensió deformació del model. 
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A.3.2 Assaig uniaxial a tracció model elàstic 

 
En aquest cas s’ha fet un assaig uniaxial per comprovar que el material segueix 
exactament la corba que s’ha introduït, fig.A.3 

 
La resposta obtinguda segueix el comportament definit com es pot veure en la figura 
A.4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. A.4.Corba tensió deformació de l’assaig uniaxial a compressió  
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B.1. Objectiu 
 
L’objectiu del present document és la creació de la part central de la galeria nord del 
claustre de la Catedral de Girona i la intercomunicació entre diferents programes. 

 
B.2. Introducció 
 
La tipologia constructiva de la galeria nord del claustre és diversa. Els porxos estan 

formats per arcs de mig punt, que descansen sobre parells de columnes i a les 

cantonades,  i cada tres, quatre o cinc columnes, trobem les pilastres. A la planta baixa 

l’element sustentant és una volta de canó. Igualment succeeix a la planta primera.  

 
La volta de la planta baixa es recolza en un mur i en l’estructura de pilars i columnes 

dobles. A la planta primera la volta es recolza en dos murs de 0.95 m. El mur interior 

disposa de finestres situades de manera continua. Tota l’estructura es descàrrega per 

un mur per la part nord, i un altre per la part sud. 

 
B.3. Procés de creació 
 
B.3.1. Software 

 
Donades les característiques geomètriques del claustre és necessari un programa 3D 

potent. Es podria pensar en varies opcions. Primer de tot cal decidir si es treballa amb 

malla amb superfícies o amb volums. Donats els resultats contradictoris que han donat 

estudis anterior, la millor opció és treballar amb volums ja que per fer formes d’aquest 

tipus seria el més aconsellable i a més a més, ens permet realitzar contactes entre les 

superfícies dels cossos. Això farà que es compliqui la realització. La opció que el 

projectista va creure més adient és dibuixar i modelitzar els cossos amb el programa 

Pro/Engineer, ja que és un programa molt robust que ens permetrà fer el muntatge 

dels cossos i així assegurar-nos els contactes entre ells i després extreure el model del 

muntatge per introduir-lo al ANSYS o ANSYS Workbench. A partir d’aquí generar tots 

els anàlisis possibles. 
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B.3.2. Evolució del disseny 

 
Amb el programa Pro/Enginneer creem els diferents volums del nostre model. 

 
B.3.2.1. Cos del la galeria nord del Claustre de la catedral de Girona: 
 
Amb diferents extrusions creem el volum del cos del Claustre: 
 

 
Fig. B.1.Extrusió de la meitat de tot el cos del claustre 
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Fig. B.2.Amb una extrusió creem el volum de sota els capitell 

 
Fig. B.3.Extruim els arc entre columnes 
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Fig. B.4.Extruim les finestra del pis superior 

 
Fig. B.5.Extruim la volta de canó inferior i de mig punt superior. 
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Fig. B.6.Generem simetria per obtenir tot el cos. 

 
B.3.2.2.  Columna  

 
Fig. B.7.Extruim un cilindre que serà una columna. 
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B.3.2.3.  Capitell 

 
Fig. B.8.Extruim un cos cònic que serà un capitell. 

 
B.3.2.4.  Muntatge de tot el model 

 
Creem el muntatge del cost amb les columnes i els capitells, imposem els contactes 
entre els capitells i el cos del claustre , i les columnes amb els capitells. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.9.Tot el muntatge. 

Cos del Claustre

6 conjunts  
Capitell-Columna 



MODELITZACIÓ NUMÈRICA SISTEMA 
 DE DESCÀRREGA D’UNA COLUMNA    MEMÒRIA I ANNEXOS 

DE LA CATEDRAL DE GIRONA                                   ANNEX B: ESTUDI DE LA INTERCOMUNICACIÓ    

 
 

 89

Creem un eix de coordenades nou que serà l’eix de coordenades comú per a tots els 
sòlids, per tal de poder-los exportar. Cal tenir amb compte que si creem aquest nou eix 
de coordenades girat amb les coordenades adequades es representarà correctament 
amb e programa ANSYS ja que amb aquest software l’eix vertical per defecte és l’eix 
Y. 

Fig. B.10. Nou eix de coordenades relatives anomenat EIXOS. 

 
B.3.2.5.  Intercanvi de fitxers 

 
Per tal de poder exportar els sòlids individualment caldrà que anem eliminant tots els 
altres del conjunt, així com caldrà eliminar les relacions de contactes i referències que 
hem creat per tal de poder realitzar el conjunt; però ens caldrà mantenir l’eix de 
coordenades que hem creat. 
En el següent exemple eliminarem tots els volums excepte un dels conjunt 
columna+capitell. Així mateix s’ha fet amb cada una de les parts del conjunt. 

 
Seleccionem el cos que volem eliminar, cliquem amb el botó esquerra del ratolí sobre 
el cos que volem eliminar. Seleccionem amagar (Suppress). 
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Eliminarem (Supress) el 
cos del claustre 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.11. Eliminació del cos del claustre. 

 
S’obrirà un quadre en el que seleccionem Options>> 
 
 
 
 
 
 
 

Fig. B.12. Opcions per a la supressió. 

 
Sens obrirà una nova finestra, en la podrem triar quines parts del conjunt volem 
amagar (Supress) i quines no (Suspend) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.13. Relació de parentes entre peces. 
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En aquest exemple, no amagarem un dels conjunt de columna i capitell i els eixos de 
coordenades que hem creat: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.14. Selecció dels cossos a conservar i eliminar. 

 
Un cop acceptada (OK) les parts del conjunt a amagar (Supress).  

 
Com que teníem relacions de referències i contactes entre el conjunt Columna-Capitell 
que volem conservar i el cos del claustre, ens sortirà el següent missatge a la pantalla: 

 
Fig. B.15. Missatge de relació entre cossos. 

Elements a eliminar 



MODELITZACIÓ NUMÈRICA SISTEMA 
 DE DESCÀRREGA D’UNA COLUMNA    MEMÒRIA I ANNEXOS 

DE LA CATEDRAL DE GIRONA                                   ANNEX B: ESTUDI DE LA INTERCOMUNICACIÓ    

 
 

 92

En el menú desplegable que s’ha obert al mateix temps, seleccionarem la opció Quick 
Fix>Redefine>Done.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. B.16. Redefinir les relacions entre cossos. 

 
Ara podríem redefinir les relacions que hi havia entre els cossos del conjunt, en el 
nostre cas eliminarem aquestes relacions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.17. Eliminació de les relacions 
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Com es pot veure en la següent figura B.18, de tot el conjunt ja només queda el 
capitell amb contacte amb la columna i els eixos de coordenades. 
 

 
Fig. B.18. Resultat d’eliminar totes les part del conjunt que no volíem. 

 
B.3.2.5.  Creació del fitxer d’intercanvi 

 
L’intercanvi de fitxers entre el programari Pro/Engineer a ANSYS és a través de fitxers 
amb extensió *.IGS. En aquest punt explicarem com generar l’arxiu IGES de 
Pro/Engineer per poder-lo importar després amb ANSYS. 
Anem a File>Save a Copy... 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.19. Guardar el model amb un fitxer IGES. 
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Seleccionem el format amb que volem guardar el sòlid, en el nostre cas serà en format 
IGES (*.igs) i escriurem el nom amb que volem que es guardi.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.20. Guardar el model amb un fitxer IGES. 

 
Un cop acceptat (OK). S’obrirà una finestra en la que hem de seleccionar el que volem 
que es guardi en el fitxer *.igs, per defecte està seleccionada “Surfaces”, el que volem 
guardar és tot el volum per tant marcarem l’opció “Solids”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.21 Guardar el sòlid. 
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Si no volem que utilitzi el sistema de coordenades global que utilitza el proengineer 
“Default”, haurem de seleccionar l’opció “Coordinate System”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.22. Elecció del sistema de coordenades relatiu. 

 
Amb el cursor cliquem sobre els eixos de coordenades relatiu que hem creat, podrem 
veure que hem seleccionat com a sistema de coordenades el nostre ja que en la 
finestra es veurà el nom que té l’eix seleccionat (en el nostre cas té el nom 
“EIXOS:F5(CSYS)”). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. B.23. Exportar el fitxer IGES. 
 
Un cop acceptat “OK”. Ja s’haurà generat un fitxer *.igs del nostre cos amb, el nostre 
sistema de coordenades relatiu, que es pot exportar al programa ANSYS. 
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B.3.2.6. Model amb Ansys Workbench 
 
Executem el programa Ansys Workbench 

 
Fig. B.24. Finestra d’inic de ANSYS Workbench. 

 
Primer de tot haurem de crear una nova geometria, per tant harem de seleccionar la 
icona “Geometry”. 
 
S’obrirà la finestra per tal de crear una nova geometria, en el nostre cas importarem 
eles fitxers *.igs que hem creat amb el ProEngineer. File>Import External Geometry 
File... 

 
Fig. B.25. Importar fitxer de geometria. 
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Busquem l’arxiu *.igs que volem importar. 

 
Fig. B.26. Elecció del fitxer *.igs que volem importar. 

 
Un cop importat ens cal generar-lo. Cliquem amb el botó dret del ratolí sobre la icona 
de la geometria importada i cliquem sobre la opció generar (“Generate”). 

 
Fig. B.27. Generació de la geometria importada. 
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Ara ja veurem el volum que hem importat: 

 
Fig. B.28. Representació del volums importats. 

 
Si volem importar més de dos volum i el programa ens els distingeixi com a parts 
diferents, cal que abans d’importar una altre fitxer cal congelar (“Freeze”) la geometria 
que hem creat (Botó esquerra del ratolí>Insert>Freeze). 

 
Fig. B.29. Congelar els cossos. 
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En la següent figura es pot veure, al costat esquerra, l’arbre amb tots els volums 
importats. Com es pot veure a la part inferior-esquerra de la finestra s’han generat 13 
parts o cossos, que era el que volíem. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Fig. B.30. Tot el model. Com es pot observar a la 
 part de baix a l’esquerra hi ha 13 cossos diferents. 

 
 
Si ara creem una simulació d’aquesta geometria que hem creat. Tindrem diferents 
cossos que els hi podem definir les característiques del material de cada un d’aquest i 
els contactes entre els diferents cossos. I posteriorment solucionar  i analitzar una 
certa hipòtesi de càrregues i condicions de contorn. 
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C.1. Objectiu 
 
L’objectiu del present document és la creació d’un model de la part central de la galeria 
nord del claustre de la Catedral de Girona. Zona a on es va realitzar l’any 2006 les 
proves de càrrega [Reg.5]. Per tant es podrà resoldre aquest model amb el programa 
d’element finits ANSYS i comprovar els valors obtinguts amb els reals. 

 
C.2. Introducció 
 
És molt important recordar que el programa ANSYS no se li introdueixen les unitats 
amb que es vol treballar sinó que es treballa amb unitats coherents. Abans de 
començar a treballar s’ha de decidir quines unitats es faran servir i s’ha de respectar 
aquest criteri durant tota la simulació. 

 
Amb tots els sistemes d’unitats amb que pot treballar el programa: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.1. Sistema d’unitats. 

 
En aquest cas s’ha escollit treballar amb unitats del SI (m, N, Pa) per les dimensions 
del nostre model, ja que és molt gran. 

 
C.3. Característiques del material 
Els materials utilitzats són uns materials amb les següents característiques: 
Les columnes i els capitells tindran les característiques de la pedra de Girona (1): 
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Fig.C.2. Característiques de la pedra de Girona. 

 
Corba esforç-deformació: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.3. Corba Esforç deformació de la pedra de Girona. 

 
Per un altre costat tindrem les característiques de l’obra de fàbrica del cos del claustre 
i de les piles laterals: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.4. Característiques de la fàbrica 
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Corba esforç-deformació 
 
 
 
 
 
 
 
 
 
 
 
                 Fig.C.5. Corba esforç-deformació de la fàbrica. 

 
C.4. Modelització 
 
C.4.1.  Escollir els tipus de materials 

 
Seleccionem els elements que els elements que utilitzarem en la modelització. En el 
nostre cas escollirem l’element SOLID 95 pel cos del claustre, hem escollit aquest 
tipus d’element perquè al tenir una geometria amb molts angles aguts cal escollir un 
tipus d’element que es pugui mallar amb elements de tipus tetràedres. Per un altre 
costa per a definir els capitells i columnes escollirem un element tipus SOLID 65. En la 
figura # es pot veure els dos elements. 
Preprocessor>Element Type>Add/Edit/Delete 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.6. Elecció del tipus d’element 

 
C.4.2.  Propietats dels materials 

 
Ara que ja tenim els elements llestos per ser utilitzats. Ara ens cal definir els materials. 
Per fer-ho poder entrar a Preprocessor>Material Prop>Material Models. Apareixerà 
una finestra amb diferents opcions de materials a utilitzar, agrupats segons 
característiques del material. Aquí podríem definir les característiques dels materials a 
utilitzar com mòduls de Young, Coef. de Poisson, densitat,etc.  
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Però si hem d’usar molt sovint els materials és més pràctic crear un petit arxiu de text 
amb l’extensió *.SI_MPL i importar-lo Preprocessor>Material Prop>Material 
Library>Import Library 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.7.Definir el sistema d’unitats de l’arxiu de material *.SI_MPL 

 
Escollim el sistema d’unitats amb el que estan les característiques del material.  
 
 
 
 
 
 
 

 
Fig.C.8 Elecció característiques materials, arxiu *.SI_MPL 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.9.Característiques del materials obra de fàbrica (Cos del Claustre) i Pedra de Girona (Columnes i 
Capitells) 

corba tensió;σ (Pa) – deformació;ε no lineal

Tensió límit a tracció;σut (Pa) 

Tensió límit a compressió;σuc  (Pa)
 

Mòdul de Young ;E (Pa)

Coef. De Poisson ;μ 

Densitat;ρ (Kg/m3)

Número del Material
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C.4.3.  Geometria 

 
Importem els arxius IGES creats amb el Pro/Engineer. 
File>Import>IGES... 
Importem el cos del claustre, els 6 capitells i les 6 columnes. Obtindrem el conjunt que 
es pot veure en la figura C.10. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig.C.10.Tot el claustre. 

 
Un cop creat el conjunt cal guardar tancar i tornar a obrir el model, perquè el programa 
pugui seguir treballant amb aquesta geometria. 

 
C.4.4.  Mallat de les peces 

 
Com que primer mallarem el cos amb l’element SOLID 95 i amb les característiques 
del Cos del Claustre(mirar Fig.C.11). Hem de seleccionar per mallar només el cos del 
claustre. 
Main menu>Select>Entities...  
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Fig.C.11.Seleccionem només el cos del claustre. 
 
Escollim per seleccionar volums (Volumes), marquem el cos del claustre i fem un 
Replot. Com es pot veure en la fig. # es representarà només el cos del claustre. Ara ja 
podem mallar-lo. 
Preprocessor>Meshing>Mesh Tool. 

 
S’obrirà una finestra a on podem trobar totes les opcions del procés de creació dels 
elements i amb la distribució que es vulgui.  
Per discretitzar el cos del claustre, a la part de dalt de la finestra al costat de la finestra 
desplegable que per defecte posa “Global” es clica en “Set”, com es pot veure en la 
figura C.12. 
 
 
 
 
 
 

Fig.C.12. Seleccionem només el cos del claustre. 

 
S’obrirà una finestra com la de la figura C.13 a on hem d’escollir el tipus d’element 
amb el que volem mallar i les seves característiques. 
 
 
 
 
 
 
 
 
 
 

Fig.C.13. Element i característiques del cos del claustre. 

 
Per mallar en la finestra Mesh Tool es collirem l’opció Size Controls>Lines>Set per tal 
de dividir les línies de la geometria. Seleccionarem totes les línies de cos del claustre 
Pick All. Apareix una finestra on es pot introduir la mida de cada element o el nombre 
d’elements en que es vol dividir les línies seleccionades. En aquest cas dividirem 0,40 
m, Fig. C.14. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.14. Finestra on es defineix la mida dels elements o el nombre que n’hi haurà. 

Tipus 

Característiques del 
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Ara ja podem mallar tot el volum. De la finestra Mesh Tool a la part baixa s’elegeix 
Mesh>Volumes, s’hactiva Shape:Tet per dividir el volum amb petits tetràedres i Free 
per fer un mallat lliure, pel tipus de geometria tant complexa del cos del claustre 
aquesta és la única forma de mallar-lo. 

 
Ara el claustre passa de ser un volum a ser un nombre molt gran d’elements, com es 
veu a la figura C.15. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.15. Cos del claustre discretitzada 

 
Per mallar les columnes i capitells primer de tot hem de tornar a seleccionar tots els 
elements. Main Menu>Select>Everything. 
Igualment com a l’inici d’aquest apartat seleccionarem les columnes i els capitells. 
Main Menu>Select>Volums marquem amb el ratolí els capitells i columnes i acceptem 
Apply. Replot. Ara veurem només les columnes i capitells del model, fig.C.16. 
 
 
 
 
 
 
 
 
 

Fig.C.16. Veiem les columnes i capitells. 

 
Ara igual que abans amb la opció Mesh Tool cal seleccionar l’element SOLID 65 i el 
tipus de material Pedra de Girona (veure Fig #).es collirem dividir les línies de tots els 
elements (Columnes i Capitells). amb un elements de mida 0,05m (divisions de 5 cm) i 
després mallarem   amb les opcions Mesh:Volumes, Hex per dividir els volums amb 
elements tipus hexagonals i Sweep perquè es faci una “escombrada” de les divisions 
generades abans. 
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Fig.C.17. Element i característiques de les columnes i capitells. 

 
En la figura # podem veure que s’ha discretitzat tot el model amb materials diferents i 
característiques diferents. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.C.18. Color blau clar(Cos Claustre) element SOLID 95 i característiques obra de fàbrica i color lila 
(Columnes+Capitells) SOLID65 i característiques Pedra de Girona. 

 
C.4.5.  Crear els contactes 

 
Un cop mallats tots els cossos ja podem crear els contactes entre superfícies per fer-
ho utilitzarem em Contac Manage, Fig. C.19. 
 
 
 
 
 
 
 
 
 

Fig. C.19.Iniciar el generador de contactes Contact Manager 
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S’obrirà la finestra del generador de contactes Contact Manager, on seleccionarem la 
icona de l’esquerra per generar un contacte nou: 
 
 
 
 
 
 
 
 
 
 

Fig. C.20. Crear contacte nou. 

 
S’obrirà la finestra Contact Wizard ,fig. ,on es definirà el tipus de contacte que volem 
crear en  el nostre cas serà entre superfícies Areas i Flexible. Si cliquem en Pick 
Target...podrem definir la superfície inferior del contacte que estem creant. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.21. Seleccionar la superfície inferior del contacte 

 
Haurem de marcar amb el ratolí la superfície que serà la inferior del contacte “Target” 
en el nostre cas serà la superfície superior del capitell. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.22. Aquí podem veure la superfície inferior del contacte. 

Superfície inferior del contacte 
Targe 
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Acceptem la superfície 
 seleccionada 

 
 
 
 

Fig. C.23. Acceptem la superfície de contacte. 

 
En la finestra del “Contact Wizard”, marquem la opció següent (“Next”).  
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.24. Seguim amb la creació del contacte. 

 
Igualment que en el pas anterior, ara hem de seleccionar la superfícies inferior del 
contacte Contact. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.25. Selecció de la superfície superior del contacte. 



MODELITZACIÓ NUMÈRICA SISTEMA   MEMÒRIA I ANNEXES 
 DE DESCÀRREGA D’UNA COLUMNA                                          ANNEX C: MODELITZACIÓ DE LA GALERIA NORD 
CATEDRAL DE GIRONA                                                                     DEL CLAUSTRE DE LA CATEDRAL DE GIRONA 

 

 111

 
 

Fig. C.9. Seleccionar la superficie superior del contacte 
 

 
 
 
 
 
 
 

Fig. C.26. Aquí podem veure la superfície superior del contacte. 

 
Acceptem (“Apply”) i seguim (“Next”). 
En la següent finestra podríem definir una coeficient de fricció, en el nostre cas ho 
deixarem en blanc, lo que si que farem és canviar les opcions del contacte (“Optional 
setting...”). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.27. Modificació de les opcions del contacte. 

 
Canviarem el tipus de contacte (“Behavior of contact surface”) que bé per defecte 
“Standard i seleccionarem el tipus de contacte Rough que permet que es pugui 
separar el contacte. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. C.28.Canviem el tipus de contacte. Per defecte hi ha  
l’Standard i el canviarem per Rough (superfície rugosa)  

que permet la separació del contacte. 

Superfície superior del contacte
Contact 
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Acceptem els canvis OK. Finalment en la finestra Contact Wizard crearem el contacte 
Create 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.29. Creació del contacte. 

 
Sorgirà un missatge que ens diu que s’ha creat el contacte. Finish 
 
 
 
 
 
 
 

Fig. C.30.Missatge del tipus de contacte creat. 

 
Ara faríem el mateix pels 5 contactes que falten entre columnes i cos del claustre i el 6 
entre columnes i capitells. En la figura C.31 es pot veure el llistat dels 12 contactes 
entre cossos i el la figura C.32 es pot veure els 12 contactes creats. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.31.Llista del 12 contactes amb les seves característiques principals. 
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Fig. C..32. Represetnació dels cotnactes. 

 
C.4.5.  Condicions de contorn i forcés aplicades. 

 
Arribats a aquest punt només resta definir les condicions de contorn i les forces 
aplicades sobre el claustre. Primer de tot restringirem el moviment dels laterals ja que 
el nostre model només és un tros de l’ala nord del claustre de la catedral. 
Solutión>Define Loads>Apply>Structural> Displacement>On Areas. 

 
Seleccionem les dues àrees dels laterals, al clicar OK apareix una finestra com la de la 
figura C.33 a on elegirem UZ. Això seria el mateix que si apliquéssim Symetria. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.33.Visualització dels contactes. 
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Farem el mateix restringint el desplaçament vertical de la base del cos del claustre, les 
bases de les piles laterals i la base de les columna. Elegim UY. Es pot veure totes les 
condicions de contorn en la figura C.34. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. C.34.De les restriccions 

 
Com a forces aplicades al model hem de considerar el pes propi del conjunt, això vol 
dir definir la gravetat de 9,8 m/s2. 
Solutión>Define Loads>Apply>Structural>Inertia>Gravity 
 

 
 

 
 
 
 
 
 
 
 

Fig. C.35.Introduim la gravetat amb la direcció vertical. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Fig. C.36.conjunt amb totes les condicions de contorn i forcés. 
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ANNEX D: DISSENY DEL PILAR SECUDARI 
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D.1. Objectiu 
 
L’objectiu del present document és el disseny d’un puntal secundari realitzat amb 
perfils metàl·lics que va servir en el moment de la realització de les proves de càrrega. 
 
 
D.2. Introducció 
 
Durant la preparació de les proves de càrrega en el claustre de la Catedral de Girona 
el projectista va poder participar-hi de forma tangencial dissenyant un puntal secundari 
que ajudi a mantenir l’estabilitat del sistema de càrrega a mesura que es va aplicant la 
càrrega en els puntals hidràulics. Al seu torn també varen servir per a l’obtenció dades 
dels seus allargament a través d’unes galgues extensiomètriques. 

 
Fig. D.1.Vista general del muntatge. 

 
Puntals secundaris formats per perfils quadrats metàl·lics buits de 100x100mm, amb 
un gruix de 5mm, que es situa en la part oposada dels puntals hidràulics. El sistema 
d’anivellament amb els suports està format per placa i contraplaca de 250x250x8mm i 
reforçades amb carteles. La unió amb els xindris es realitza amb una placa metàl·lica 
de 150x150x5mm. 

 
En cada un dels puntals secundaris s’hi adhereixen dues galgues extensomètriques 
per tal de controlar les deformacions en la seva part exterior que dona al pati del 
claustre i en la part interior que dona la volta de canó. 
 
 
 
 
 
 

Puntal 
secundari 
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D.3. Esquema puntal secundari 

  
Fig. D.2.Puntal secundari. 

 
Aquest element es disposa en la part de l’arc oposada a la que es troben les columnes 
sobre les que es du a terme l’assaig. Estan formats per perfils fixats a un sistema 
d’anivellament format per placa i contraplaca. 
La connexió amb el xindri s’efectua de la mateixa manera que el puntal instrumentat 

 
Contacte inferior 
El puntal recolza amb el terra a través d’una placa de distribució. Aquesta tindrà un 
sistema de contraplaca amb una femella i una contrafemella, per poder ajustar l’alçada 
del puntal i per poder posar i treure. 

 
Sistema de fixació 
Aquesta peça es connecta a l’element a desplaçar. Si aquest element es pla, la 
connexió generalment es produirà de forma directa: en casos com el que es dona 
aquest projecte, el contacte es produirà a través d’un element intermedi. 
La platina superior d’aquest dispositiu, presenta uns trepants. Mitjançant cargols o 
medis semblants, es pot fixar al element assajat. 

 
Sistema de riostrament 
S’han deixat dos orelles al mateix costat del puntal, per si calgués un arriostrament 

 
Instrumentació dels puntals secundaris 
A través de la instrumentació dels puntals secundaris, es podrà establir si hi ha una 
migració de la càrrega cap a ells en el moment del test. 
L’adquisició de dades en aquests elements permetrà una comprensió completa del 
fonament tenso-deformacional observat. 
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cm
A
Ix 89.1

33.5
19

==

<=== 2/124833.533.1·5000* cmkgANσ

D.4. Càlculs de disseny del puntal secundari 
 
SOL·LICITACIÓ: 5.000 kg a compressió 
Característiques de l’acer emprat el A42: 

σut=4200 kg/cm2 
σy=2600 kg/cm2 

 
D.4.1. Pilar 

 
Des de la base del pilar fins a la part superior del capitell hi ha una distància de 1’56 m. 
Per tant calcularem el perfil tubular del nostre puntal amb aquesta alçada màxima, tot 
hi que sabem que no tindrà l’alçada total, i amb un coeficient de majorasió de les 
càrregues de γf= 1,33, segons la normativa.  

 
Hem decidit usar un perfil tubular quadrat per la seva facilitat en practicar-hi 
soldadures . 
Per evitar el vinclament del pilar usarem un perfil tubular quadrat com a mínim del 
50,3: 
 

Ix=19 cm4 
A=5,33 cm2 

                                                                       2/2600 cmkgu =σ  OK 
Comprovació a vinclament: 

i= 

 

 

Longitud de pandeig: mmLL rp 56.156.11 =⋅=⋅= β  ; Barra biarticulada β=1  

===
cm
cm

i
Lp

89.1
156λ 82.54       ω=1.57 

22
2

* /2600/1253
33.5

57.16.15000 cmkgcmkg
cm

kg
u =<=

⋅⋅
= σσ  OK,COMPLEIX 

 
D.4.2. Cargols 

 
Per a la unió usarem cargols ordinaris (T) d’acer A4.6 (σu=2400 kg/cm2) 
La sol·licitació que ha d’aguantar cada cargol serà de 5000kg/4=1250kg de 
compressió. 

 
Valor orientatiu:  
  2.052.05 −⋅=−⋅= eCANYAφ  
 

2
* 46.11250

D
kg
⋅

⋅⋅
=

π
σ ≤2400 kg/cm2 

 
D>10 mm                                                  Fig. D.3.Dimensions femella. 
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cm
A
Ix 383,0

75,2
403,0

==

Amb cargols T 20x80,A8t de diàmetre interior de 16.93 mm ja complim 
  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. D.4.Dimensions dels cargols. 

 
Ara hem de calcular els cargols per vinclament; suposarem que la longitud de 
vinclament sigui d’uns 5 cm; per permetre tenir espai suficient per poder situar i 
treballar amb la clau per collar les femelles. 
Longitud de vinclament: cmcmLL rp 5.25.5.0 ==⋅= β  ; Barra empotrada-empotrada 
β=0.5  
 

Ix= =
⋅

=
⋅

64
693,1

64

44 cmdi ππ
 0,403 cm4 

Ar=2,75 cm2 

 

i= 
 
 

===
cm

cm
i

Lp

383,0
5,2λ 6,53   ω=1,02 (com que no surt n la taula  

agafem el mínim) 
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22
2

* /2400/742
75,2

02,16.11250 cmkgcmkg
cm

kg
u =<=

⋅⋅
= σσ  OK,COMPLEIX 

 
El forats per cargols ordinaris de 20 mm seran de øforat=21 mm 

  
D.4.3. Placa d’ancoratge 

 
Segons la norma les disposicions constructives de les unions cargolades : 

 
Fig. D.5.Normativa unions cargolades. 

 
Valor mínim: Cantell frontal e1>2da= 2·21=42 mm 
                 Cantell lateral e2>1.5da=31.5 mm 

 
Valor màxim: A qualsevol cantell e<3 da=63 mm 
               e<6t 

 
da; diàmetre dels forats 
t; espessor mínim  

 
Tenint en compte tots aquest valors col·locarem els forats a 50 mm (42,315<50<63) de 
tots els cantells, per facilitar la seva execució. 

 
Per determinar la distància dels forats amb la peça tubular perpendicularment soldada 
a  la placa d’ancoratge tindrem en compte que les femelles tenen una distància entre 
arestes de e=34.6 mm i hem de deixar espai per la col·locació de la clau. Deixarem un 
espai de 25 mm. 
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Així ens quedarà la placa: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Fig. D.6.Esquema de la placa. 

 
Per calcular la secció(t) mínima de la placa d’ancoratge inferior ho hem fet amb un 
programa d’elements finits com és el RISA 3D: 

 

 
 

 
Fig. D.7.Model amb RISA3D de la placa e=8 mm. 
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Placa de 8 mm d’espessor: 
Màxims Mínims 

 
Fig. D.8.Tensions a la placa. 

 
Podem observar que amb una placa de 200x200x8 mm ja en tenim prou per aguantar 
els esforços. 
Com a placa superior col·locarem la placa mínima indispensable per exemple 
100x100x5. 
 
Així la disposició constructiva seria aquesta; 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. D.9.Esquema de muntatge. 
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Però per assegurar-nos que el nostre puntal no vinclarà col·locarem un perfil 
tubular de 100.5 aquest fet ens farà variar les dimensions de la placa inferior si volem 
conservar les condicions que havíem considerat per a la disposició dels cargols. 

 
Valor mínim: Canto frontal e1>2da= 2·21=42 mm 
 Canto lateral e2>1.5da=31.5 mm 

 
Valor màxim: A qualsevol canto e<3 da=63 mm 
 e<6t 

 
Tenint en compte tots aquest valors col·locarem els forats a 50 mm (42,315<50<63) de 
tots els cantells, per facilitar la seva execució. 

 
Per determinar la distància dels forats amb la peça tubular perpendicularment 

soldada a  la placa d’ancoratge tindrem en compte que les femelles tenen una 
distància entre arestes de e=34.6 mm i hem de deixar espai per la col·locació de la 
clau. Deixarem un espai de 25 mm. 

 
Ara la placa d’ancoratge inferior, serà: 
 

 
Fig. D.10.Esquema de la placa. 
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Si es recalcula l’espessor de la placa amb les noves dimensions.  

 
 

 
Fig. D.11.Resultats. 

 
Amb una placa de 250x250x8 mm ja en tenim prou, estem per sota de la tensió 
admissible ( 2/2600 cmkgu =σ ) 
Màxims Mínims  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. D.12.Tensions a la placa. 
La placa superior ara haurà de ser del 125x125x5 mm. 
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D.4.4. Carteles 

 
Per assegurar l’estabilitat del pilar, encara que no ens caldria, col·locarem unes 
carteles de 50 mm d’espessor. 

 
 

C=(75/2)/sin45=53 mm 

 
Si suposem que cada cartela aguantés Rc

*=1250 kg·1.33=1662.5 kg ,el moment 
d’esgotament de la cartela serà: 

Mp=tc·c2·σu/4=0.5·5.32·2600/4=9130 kg·cm 

 
tc; espessor de la cartela 

 
===

5.0
3,50283,0·0283,0

ct
cλ 0,3 

 
23,2·07,114,0

2
≈+−⋅⋅= λλEC cm 

 
Com que es compleix: 

Rc·dc<CE·Mp 
 

dc; distancia perpendicular del centre al punt d’aplicació de Rc 

 
1662,5·7,5=12468 kg·cm2 < 2·9130=18260 kg·cm2 COMPLEIX 

 
CORDÓ DE OLDADURA HORITZONTAL: 

 
Component horitzontal; 

kgR
mm

mmRcT cc 5.1662
75

75· ** ===  

 

Rc*



MODELITZACIÓ NUMÈRICA SISTEMA 
 DE DESCÀRREGA D’UNA COLUMNA    MEMÒRIA I ANNEXOS 
DE LA CATEDRAL DE GIRONA                                                           ANNEX D: DISSENY DEL PILAR SECUNDARI   

 
 

 126

 
segons la formulació de la norma, la secció de la gorja serà; 

 
cmcmkg

kg
L

Fa
u 5.7/260075.0

5.1662
·75.0

2 2 ⋅⋅
=

⋅
=

σ
  a=2,2cm≈3 mm 

 
disposarem cordons de 3 mm de secció de gorja a cada costat de la cartela. 
 
Pels cordons verticals també usarem cordons de 3 mm de gorja. 
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ANNEX E: ESTUDI ECONÒMIC 
 

SUMARI 

 
E.1. Estudi econòmic................................................................................................ 128 
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E.1.  ESTUDI ECONÒMIC 

 
Estudi econòmic per la realització de l’estudi: 

 

 COST UNITARI UNITATS  COST TOTAL 
COST DE DESENVOLUPAMENT DE L'ESTUDI     
Hores d'anàlisi 30 €/h 200 6.000 € 
Desplaçaments i dietes 10 € 15 150 € 
       
      Subtotal:6.150 €
COST DE REDACTAT DE L'ESTUDI     
Hores d'organització de l'estudi 18 €/h 30 540 
Hores de redactat de l'estudi 24 €/h 50 1200 
Material 150 €/h 1 150 
      Subtotal:1.890 €
    
TOTAL REALITZACIÓ DEL PROJECTE   8.040€ 
 

L’estudi té un pressupost de VUIT MIL QUARANTA EUROS. (8.040 €) 

 

 
 
 

Girona, setembre del 2009 
 

L’Estudiant redactor del projecte 
 
 
 
 
 
 
 
 

Narcís Serra Font 
 

 


